
 

 

Name _______________________________      AP CHEM               ___/___/___ 
 
AP Chem Lab 1 Vulgate: Beer’s Law 
 
Background: THEORY OF SPECTROPHOTOMETRY 
Spectrophotometry is a quantitative method of analysis involving the principles associated with how visible light interacts with atoms.  
Visible light is a small portion of the electromagnetic spectrum and includes the colors we observe (red, orange, yellow, green, blue 
and violet).  It consists of electromagnetic radiation whose wavelengths range from 400-700 nm.   
 
When white light is observed, what is actually being seen is all the colors of light combined.  When this light passes through a 
substance, certain energies (or colors) of light are absorbed while the other color(s) are allowed to pass through or are reflected.  This 
is why some substances appear colored.  The color we see is the combination of the energies of visible light that are not absorbed by 
the sample.   If the substance does not absorb any light, it appears white or colorless.  A solution appears a certain color due to the 
absorbance and transmittance of visible light.  For example, an orange solution appears orange because it is absorbing all of the colors 
except orange.  A sample may also appear orange if all colors of light except blue are transmitted.  This is because blue and orange are 
complimentary colors.  (see figure below right) 
 
Many compounds involving transition elements are colored.  This is because the 
transition metals include "d" electrons in its atomic structure.  The spacing of these "d-
orbitals" allow for electronic transitions within the energy range of the visible region of 
the electromagnetic spectrum.  Compounds containing the alkali and alkaline earth 
metals are white, due to having only "s" electron transitions.   More energy is required 
to cause this type of transition and, thus, light of shorter wavelength is involved. 
 
The amount of light absorbed by a solution is dependent on the ability of the 
compound to absorb light (molar absorptivity), the distance through which the light 
must pass through the sample (path length), and the molar concentration of the 
compound in the solution.  This relationship is known as Beer's Law and is represented by the equation: A = abc 
where A is the absorbance, a is the molar absorptivity, b is the path length and c is the molar concentration.  If the same compound is 
being used and the path length is kept constant, then the absorbance is directly proportional to the concentration of the sample. 
 
A spectrophotometer is used to provide light of certain energy (wavelength) and to measure the absorbance of that light.  The basic 
operation of the spectrophotometer includes a white light radiation source which passes through a monochromator.  The 
monochromator is either a prism or a diffraction grating which separates the light into the colored components and allows only light of 
a particular wavelength to strike the sample.  The sample is poured into a cuvette, which is similar to a small test tube.  It is marked so 
that it can be positioned in the light beam the same way each time to avoid variations due to the differences in the composition of the 
glass.  The light passes through the sample, and the unabsorbed portion strikes a photodetector, which produces an electrical signal 
proportional to the intensity of light.  The signal is converted to a readable output that is used in the analysis of the sample. 
 
The equation, A = 2 - log %T, is worth remembering because it allows you to easily calculate absorbance from percentage 
transmittance data.   The relationship between absorbance and transmittance is illustrated in the following diagram: 
So, if all the light passes through a solution without any absorption, then absorbance is zero, and percent transmittance is 100%. If all 
the light is absorbed, then percent transmittance is zero, and absorption is infinite. 

The Beer-Lambert Law 
Now let us look at the Beer-Lambert law and explore its significance. This is important because people who use the law often don't 
understand it - even though the equation representing the law is so straightforward: A = abc 
Where A is absorbance (no units, since A = 2 - log %T) 
a is the molar absorbtivity with units of L mol-1 cm-1 

b is the path length of the sample - that is, the path length of the cuvette in which the sample is contained. We will express this 
measurement in centimeters. 
c is the concentration of the compound in solution, expressed in mol L-1 
The reason why we prefer to express the law with this equation is because absorbance is directly proportional to the other parameters, 
as long as the law is obeyed. We are not going to deal with deviations from the law.  



 

 

Pre-Lab Questions (answer on a separate sheet of paper): 
1.  What causes some substances to appear colored? 
2.  Explain why a green solution appears green. 
3.  Explain why a compound like iron(II) chloride is yellow and a compound of 
copper(II) chloride is teal but the compounds sodium chloride and magnesium 
chloride are white.   
4.  A student carries out an experiment to determine the equilibrium constant for a 
reaction by colorimetric (spectrophotometric) analysis. The production of the red-
colored species FeSCN2+(aq) is monitored. 

(a) The optimum wavelength for the measurement of [FeSCN2+] must first be 
determined. The plot of absorbance, A, versus wavelength, λ, for FeSCN2+(aq) is given below. What is the optimum 
wavelength for this experiment? Justify your answer. 
(b) A calibration plot for the concentration of FeSCN2+(aq) is prepared at 
the optimum wavelength. The data to the right give the absorbances 
measured for a set of solutions of known concentration of FeSCN2+(aq). 

(i) Draw a Beer’s law calibration plot of all the  
data. Indicate the scale on the axis by  
them with appropriate values.  
(ii) An FeSCN2+(aq) solution of unknown  
concentration has an absorbance of 0.300. Use the plot you drew in 
part (i) to determine the concentration, in moles per liter, of this solution. 

(c) Beer’s Law is an expression that includes three factors that determine the amount of light that passes through a solution. 
Identify these three factors. 
(d) The student handles the sample container (e.g., test tube or cuvette) that holds the unknown solution and leaves 
fingerprints in the path of the light beam. How will this affect the calculated concentration of the unknown? Explain your 
answer. 

 
On-line Virtual Lab 
1. Using a web browser, enter the following web address:  
http://phet.colorado.edu/sims/html/beers-law-lab/latest/beers-law-lab_en.html 
2.  Choose the Beer's Law simulation (you may need to double click on its square), not the Concentration simulation. 
3.  Setup: Click the red button to turn the light source on and click the Variable wavelength button to show choices in colors of light.   
4.  Move the ruler so that it is over the sample so you can measure the path length, (what we'll call variable "b"), for the cuvette.   
5.  From the pull-down menu choose the CuSO4 solution.  On the light sensor to the right, choose Absorbance (not Transmittance). 
6.  Vary the path length, b, by adjusting left and right the sample's cuvette width.   
7.  Vary the concentration, "c", of the sample using the slider.  Observe how these changes affect the Absorbance of light as it passes 
through the sample. 
 
Question 1:  In step 7, after making appropriate adjustments of b and c and seeing what happens to Absorbance, what mathematical 
relationship do you see between b, c, and the Absorbance we'll call variable "A"? 
 
Question 2:  Choose a concentration "c" and path length "b".  Record their values.  Now vary the frequency/color of light hitting the 
sample and record in a table the Absorbance and wavelength for each of 7 colors V, I, B, G, Y, O, and R.   
 
Concentration (c): _______________________  Path Length (b): _____________________________ 
 

Color Absorbance Wavelength 
Violet 

 
  

Indigo 
 

  

Blue 
 

  

Green 
 

  

Yellow 
 

  

Orange 
 

  

Red 
 

  

Concentration ( mol L−1) Absorbance 

1.1 × 10–4 0.030 
3.0 × 10–4 0.065 
8.0 × 10–4 0.160 
12 × 10–4 0.239 
18 × 10–4 0.340 



 

 

 
For those 7 Absorbance values make a plot in Excel or carefully with pencil and ruler of Absorbance (y-axis) vs. wavelength of light 
(x-axis).  The shape of this curve is given the variable letter "a" by the College Board and is called the molar absorptivity.  As you can 
see, molar absorptivity is a function of the wavelength of light hitting the sample. 
  
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
                               
 
Question 3: If you were given a sample of CuSO4 of unknown concentration and its cuvette was of the same size you used in question 
2 and you found the absorbance at a particular wavelength was 0.80 times as big as the sample you studied in question 2, what is the 
concentration of the unknown? 
  
 
 



 

 

 
 
Purpose: 
The primary objective of this experiment is to determine the concentration of an unknown copper (II) sulfate solution and to prepare a 
solution of copper(II) sulfate pentahydrate of desired molarity. The CuSO4 solution used in this experiment has a blue color, so 
Colorimeter users will be instructed to use the red LED. Spectrometer users will determine an appropriate wavelength based on the 
absorbance spectrum of the solution. A higher concentration of the colored solution absorbs 
more light (and transmits less) than a solution of lower concentration.  
 
You will prepare five copper (II) sulfate solutions of known concentration (standard 
solutions).  Each solution is transferred to a small, rectangular cuvette that is placed into the 
Colorimeter or Spectrometer. The amount of light that penetrates the solution and strikes the 
photocell is used to compute the absorbance of each solution. When you graph absorbance vs. 
concentration for the standard solutions, a direct relationship should result. The direct 
relationship between absorbance and concentration for a solution is known as Beer’s law. 
You will determine the concentration of an unknown CuSO4 solution by measuring its 
absorbance. By locating the absorbance of the unknown on the vertical axis of the graph, the 
corresponding concentration can be found on the horizontal axis. The concentration of the unknown can also be found using the slope 
of the Beer’s law curve. 
 
Objectives: 

 You will prepare and determine the absorbance of five standard copper (II) sulfate solutions from a stock aqueous solution. 
 Calculate a standard curve from the test results of the standard solutions. 
 Test the absorbance and determine the molar concentration of a copper (II) sulfate solution of unknown molar concentration. 
 Prepare a solution of copper(II) sulfate pentahydrate of requested molar concentration to be tested by the teacher. 

 
Equipment & Materials: 

Equipment Materials 

Computer (2) 100 mL beakers 100 mL 0.40 M CuSO4 * 5H2O 

Colorimeter 10-mL graduated cylinder Solid CuSO4 * 5H2O 

One cuvette 6 test tubes Distilled water 

test tube rack Volumetric flask  

Mortar Pestle   

Dropper Analytical balance  

Spatula   

 
Hazards: 
Goggles should be worn at all times.   
 

Procedure (Part 1): 
� 1. Obtain a 100 mL graduated cylinder of 0.40 M CuSO4 solution. 
� 2. Thoroughly clean (using soap and water – rinse thoroughly), dry and label five test tubes 1–5.  
� 3. Use pipets to prepare five standard solutions according to the chart below. Thoroughly mix each solution with a stirring rod. 
Clean and dry the stirring rod between uses.  You should prepare 10. mL samples for each of the following concentrations(you need to 
figure out the math): 0.40 M; 0.32 M; 0.24 M; 0.16 M; 0.080 M  
� 4. Prepare a blank by filling a cuvette 3/4 full with distilled water. To correctly use cuvettes, remember: 

• Wipe the outside of each cuvette with a lint-free tissue. 
• Handle cuvettes only by the top edge of the ribbed sides. 
• Dislodge any bubbles by gently tapping the cuvette on a hard surface. 
• Always position the cuvette so the light passes through the clear sides. 

� 5. Connect a Colorimeter to Channel 1 of the Vernier computer interface. Connect the interface to the computer using the proper 
cable. 
� 6. Start the Logger Pro program on your computer.  Start> All Programs> My Applications> Logger Pro 3.8.2 
� 7. Click on the Open Folder icon.  Open the file “17 Colorimeter.cmbl” from the Advanced Chemistry with Vernier folder. 
 
 



 

 

 
� 8. Calibrate the Colorimeter. 

 Holding the cuvette by the upper edges, place it in the cuvette slot of the Colorimeter.    
First Calibration Point 

� Choose Calibrate from the Experiment menu.  A new dialog box will open. 

�  Click   

�  Turn the wavelength knob on the Colorimeter to the “0% T” position.   

�  Type “0” in the Reading 1 edit box.  

�  When the displayed voltage reading for Input 1 stabilizes, click Keep .  
 

Second Calibration Point 

�   Turn the knob of the Colorimeter to the RED LED position 635 nm).  You will leave the colorimeter knob 
on RED for the remainder of the lab. 

�   Type “100” in the Reading 2 edit box.  

�   When the displayed voltage reading for Input 1 stabilizes, click Keep , then click DONE. 

� 9. You are now ready to collect absorbance data for the five equilibrium systems.  Click Collect  to begin data collection. 

� 10. Empty the water from the cuvette. Rinse it with ~1-mL portions of the Test Tube 1 solution. Discard the rinsing. 

� � � � � 11.  Fill the cuvette with solution #1 (2,3,4,5).  Wipe the outside of the cuvette with a tissue and then place the cuvette 
in the Colorimeter. After closing the lid, wait for the absorbance value displayed in the Meter window to stabilize. Then click Keep , 
type “1” (the trial number) in edit box, and press the ENTER key. 

� � � � 12.  Empty the cuvette contents back into the correct test tube. Rinse the cuvette with distilled water.  Rinse the 
cuvette with the next solution and repeat step 11 for each of the four remaining solutions.  
� 13.  Click on the Insert menu and choose Graph.  A new window will open with your graph.   
� 14.  Click on Linear Fit button.   
 
� 15.  From the top menu Choose: Analyze > Autoscale > Autoscale From 0. 
� 16.  From the top menu Choose: Analyze > Interpolation Calculator.  A new dialog box will open. 
� 17.  Enter your absorbance values from your data table and the concentration values will be displayed.  Record the concentrations 
in your data table. 
 

Procedure (Part 2): 
� 1. Obtain an unknown solution from the teacher.  Be sure to record the solution ID.  Use your Calibration Graph to determine the 
molar concentration  of  your assigned unknown.   
 
Procedure (Part 3): 
� 1.  Prepare a solution with the requested molar concentration and return it to me in a labeled test tube.  The test tube should have 
your names and the prepared concentration. 
 
Procedure (Part 4): 
� 1.  Empty all of your solutions in the waste beaker near the main sink. 
� 2.  Rinse all of your test tubes and cuvettes and place them mouth up in your test tube rack to dry.  Place the rack near the main 
sink. 
� 3.  Rinse your graduated cylinder and place it near the main sink. 
� 4.  Place the USB and power supply in the plastic zip-lock bag and place the colorimeter in its box. 
� 5.  Place the colorimeter and zip lock bag on the table in the middle of the room.     
 
 
 
 
 
 
 
 



 

 

 
 

Pre- Lab Rubric: Beer’s Law  
 
Pre-Lab Answers    0 1 2 3 4  5 6 7 8 
 
Virtual Lab Answers, Data Table & Graph 0 1 2 3 4 
 
 
 
Total: _____________________ / 12 
 
 
 
 
Post- Lab Rubric: Beer’s Law 
 
Lab Title, Name  & Date   0 1 
 
Lab Partners    0  1 
 
Observations    0 1  
 
Printed Calibration Curve   0 1 2 3 4 5 
 
Molarity of Unknown (+/- 0.05 M)  0 1 2 3 4 5 
 
Molarity of Prepared Solution  (+/- 0.05 M) 0 1 2 3 4 5 
 
 
Total: _____________________ / 18 
 
 
 
 


